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Performing a DFA analysis

In this tutorial, we analyze a small assembly in the DFA Product Simplifi ca� on so� ware and then we redesign that assembly 
by combining or elimina� ng parts to simplify the product structure.  The original and redesigned products are then compared 
using the results features that are incorporated into the DFA so� ware.

To begin, open the analysis fi le for the Pneuma� c control that has been installed with your DFA so� ware.  Select Open from the 
File menu, browse to DFMA\data\samples, and double click the Pneuma� c control.dfax analysis fi le.

The product analyzed in this tutorial is the small pneuma� c control pictured below.

Each of the items pictured will be added to the Structure chart on the le�  side of the main program window.  The DFA 
ques� ons will then be answered for each item so that the program can es� mate the assembly process � me and cost.

Setting up the DFA software
In order for your computer’s display to match this tutorial, be sure that your so� ware is set up to do a DFA analysis in English 
units with dimensions in inches.  Click the Analysis menu and be sure that DFA is selected.

Select Set units… from the Analysis menu and be sure the Units tab on your Op� ons dialog appears as shown below.

Click OK to close the Op� ons dialog and return to the DFA main window.

Click the Insert menu and be sure that Assembly order is selected.
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Beginning the analysis
With the Original design - step 1 analysis tab selected, click twice the Un� tled main assembly entry at the top of the Structure 
Chart and name it Pneuma� c control. 

Enter the following informa� on into the DFA Ques� ons panel.

Part number: 1234

Manufacturer Name: Pneuma� c Industries

Manufacturer Loca� on: Wakefi eld, RI

Life volume: 1000

Accept the default values for the Labor rate (40$/hr) and the Overall plant effi  ciency (85%).

Enter into the Envelope dimensions group box, the dimensions of the smallest rectangular prism that encloses the fully 
assembled pneuma� c control, 1.1, 2.5, and 3 inches.  Dimensions can be entered in any order.  Since the assembly is 
considered small, the program will assume that all parts are within easy reach of the assembly worker.

Adding the Plastic base
Add the fi rst part to the structure chart.  Choose Part from the Insert menu or click the    bu� on on the toolbar.  Name the 
part Plas� c base.

Click the Part number fi eld on the DFA Ques� ons panel and enter 1234-1.

Accept the default values for the repeat count (1) and the item weight classifi ca� on (Less than 5 lb (2.27 kg).

Accept the default rectangular shape selec� on for the Plas� c base, and enter dimensions of 1.1 in., 2.5 in., and 3 in.  
Dimensions can be entered in any order.

The Plas� c base has a func� on other than fastening or securing other items and it has a func� on other than connec� ng other 
items.  For this reason, accept the default value of Item has other func� on within the Item func� on group box.

Because the Plas� c base is the fi rst part added to the product, there are no other items that can be used to evaluate against for 
the minimum part criteria.  For this reason, choose Base part (usually only the fi rst) in the Minimum part criteria group box.

Imagine rota� ng the Plas� c base pictured below about each of its three axes, one at a � me.  For each axis, a complete 360 
deg. rota� on is required before the Plas� c base repeats its original orienta� on.  This means that the part does not repeat its 
orienta� on about any of its axes with a 180 deg. or less rota� on.  For this reason, accept the default No axes bu� on in the 
Symmetry group box.

The Plas� c base will be acquired by the assembly worker and placed into a simple fi xture so that it is ready to receive the 
remaining parts.

Grasping and manipula� ng the Plas� c base can be done with one hand and no tools and it presents no other handling 
diffi  cul� es.  Accept the default of One hand without grasping tool in the Handling requirements group box and leave unchecked 
all of the diffi  cul� es in the Handling diffi  cul� es group box.

Assuming that the Plas� c base will be placed into its fi xture and remain unsecured, accept the default Added but not secured 
bu� on in the Securing process group box.  Also assuming that the fi xture is well designed and there are no problems during 
inser� on of the part, leave unchecked all of the diffi  cul� es in the Inser� on diffi  cul� es group box.
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Based on the answers provided to the DFA ques� ons, the program has es� mated that the � me to acquire, handle, and insert 
the Plas� c base is 3.54 s.   The process � me and process cost results are shown in the status bar at the bo� om of the program 
window.

Adding the Piston subassembly
Add the piston subassembly to the Structure chart.  Choose Unanalyzed Subassembly from the Insert menu or click the  
bu� on on the toolbar.  Name the subassembly Piston sub.

Click the Part number fi eld on the DFA Ques� ons panel and enter 1234-2.

Accept the default values for the repeat count (1) and the item weight classifi ca� on (Less than 5 lb (2.27 kg).

In the Envelope dimensions group box, click the cylinder bu� on and accept 1 in. for the diameter and 1 in. for the length of the 
Piston sub.

The Piston sub has a func� on other than fastening or securing other items and it has a func� on other than connec� ng other 
items.  Accept the default value of Item has other func� on within the Item func� on group box.

The Piston sub must move rela� ve to the Plas� c base.  The required movement is substan� al and could not be accommodated 
with some integral elas� c elements between the Plas� c base and the Piston sub.  For this reason, click Moves rela� ve to all 
other items in the Minimum part criteria group box.  This means that the Piston sub is a theore� cally necessary item and 
cannot be designed out of the product by incorpora� ng features into the plas� c base to serve the func� on of the Piston sub.  

Imagine rota� ng the Piston sub pictured below about each of its three axes, one at a � me.  About the principal axis, the part 
requires 0 deg. of rota� on before it repeats its orienta� on.  The remaining two axes both require a complete 360 deg. rota� on 
before the Piston sub repeats its original orienta� on.  This means that the Piston sub has 180 deg. or less symmetry about one 
of its axes.  Click the One axis bu� on in the Symmetry group box.

 
Grasping and manipula� ng the Piston sub can be done with one hand and no tools, it presents no handling diffi  cul� es, and it 
will not be secured immediately upon inser� on into the base.  Accept all of the default values in the Handling requirements, 
Handling diffi  cul� es, and Securing process group boxes.

Inser� on of the Piston sub into the Plas� c base can cause problems because there are no chamfers or other features that 
would make the two items self aligning.  The Piston sub must also be released by the assembly worker before its spindle can be 
located in the small hole in the base.  This can lead to the hang-up condi� on shown here.

 
For these reasons, click Not self-loca� ng and Resistance or hang up in the Inser� on diffi  cul� es group box. 

The program has es� mated the � me to acquire, handle, and insert the Piston sub into the Plas� c base is 5.22 s as shown in the 
status bar.
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DFA questions for the Piston stop
Click the analysis tab named Original design - step 2 at the top of the program window.  This analysis is iden� cal to the analysis 
completed so far in the present tutorial except that the Piston stop, Steel spring, Steel cover and the Screws have already been 
added to the structure chart to save � me.

Click the Piston stop and note that the part number and the envelope dimensions have already been entered.

Accept the default values for the repeat count (1) and the Item weight classifi ca� on (Less than 5 lb (2.27 kg).

The Piston stop has a func� on other than fastening or securing other items and it has a func� on other than connec� ng other 
items.  Accept the default value of Item has other func� on within the Item func� on group box.

The Piston stop must obstruct the bore in the plas� c base in order to stop the Piston sub from over compressing the Steel 
spring.  It is not possible to incorporate features into the Plas� c base or the Piston sub that would provide this obstruc� on in 
the bore without preven� ng assembly of the Piston sub.  For this reason, click Separate to allow assembly in the Minimum 
part criteria group box.

Imagine rota� ng the Piston stop pictured below about each of its three axes, one at a � me.  About the principal axis, the part 
requires 0 deg. of rota� on before it repeats its orienta� on.  The remaining two axes both require a complete 360 deg. rota� on 
before the Piston stop repeats its orienta� on.  Click the One axis bu� on in the Symmetry group box.

 
The Piston stop can be grasped with one hand and requires no grasping tools, it presents no addi� onal handling diffi  cul� es, it 
is not secured immediately upon inser� on, and it presents no inser� on diffi  cul� es when it is inserted into the Plas� c base.  For 
these reasons, all of the remaining default values apply and no further responses are required for this item.  The so� ware has 
es� mated 3.22 s to acquire and insert the Piston stop.

DFA questions for the Steel spring
Click the Steel spring on the structure chart.

The part number and the envelope dimensions have already been entered and the default values for the repeat count (1) and 
Item weight classifi ca� on (Less than 5 lb (2.27 kg) are appropriate for the steel spring.

The Steel spring has a func� on other than fastening or securing other items and it has a func� on other than connec� ng other 
items.  Accept the default value of Item has other func� on within the Item func� on group box.

The Steel spring does not have to be made from a diff erent material than every other item assembled in the product so far.  
At least theore� cally, the material from which the Piston sub is made could be changed to the same spring steel used in the 
spring.  The end of the spring that is in contact with the top of the Piston sub does not move rela� ve to the Piston sub and 
combining the Steel spring with the Piston sub would not prevent the assembly of other items in the product.  This means that 
the spring is a candidate for elimina� on from the product because, at least theore� cally, a spring feature could be integrated 
into the top of the Piston sub to serve the func� on of the spring.  Accept the default value of No fundamental reason exists 
within the Minimum part criteria group box.  In the Notes group box enter Combine with Piston sub?  

About the principal axis, the Steel spring pictured below requires 0 deg. of rota� on before it repeats its orienta� on.  The 
remaining two axes of the spring have 180 deg. symmetry.  Click the Two axes bu� on in the Symmetry group box.
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The Steel spring will severely tangle when in bulk and requires two hands to manipulate and separate.  For this reason, click 
Two hands - severe nest or tangle.

The Steel spring presents no addi� onal handling diffi  cul� es, it is not secured immediately upon inser� on, and it presents no 
inser� on diffi  cul� es when it is placed into the Plas� c base.  For these reasons, all of the remaining default values apply and no 
further responses are required for this item.  The so� ware has es� mated 5.6 s to acquire and insert the Steel spring.

DFA questions for the Steel cover
Click the Steel cover on the structure chart.

The part number and the envelope dimensions have already been entered and the default values for the repeat count (1) and 
Item weight classifi ca� on (Less than 5 lb (2.27 kg) are appropriate.

The Steel cover has a func� on other than fastening or securing other items and it has a func� on other than connec� ng other 
items.  Accept the default value of Item has other func� on within the Item func� on group box.

The Steel cover does not have to be made from a diff erent material than every other item assembled in the product so far.  In 
par� cular, the Steel cover could be made from the same plas� c as the Piston stop.  The Steel cover does not move rela� ve 
to the piston stop and combining the Steel cover with the Piston stop would not prevent the assembly of other items.  This 
indicates that the Steel cover is another candidate for elimina� on because a feature could be incorporated into the Piston stop 
to serve the func� on of the cover.  Accept the default value of No fundamental reason exists within the Minimum part criteria 
group box.  In the Notes group box enter Combine with Piston stop?

The cover pictured below will repeat its orienta� on if it is rotated 180 deg. about all three of its axes.  Click Two axes for 
Symmetry.

 
The Steel cover can be grasped with one hand and no grasping tools and it presents no addi� onal handling diffi  cul� es.  Accept 
the default values in the Handling requirements and Handling diffi  cul� es group boxes.

Because the spring needs to be compressed as the cover is installed, the cover needs to be held down while the screws are 
inserted. Click Added and held down for the Securing process.

There are no features to guide the cover into place as it is inserted on top of the Plas� c base. Click Not self- loca� ng in the 
Inser� on diffi  cul� es group box. 

The so� ware has es� mated 8.49 s to acquire and insert the Steel cover.

DFA questions for the Screws
Click the Screws on the structure chart and note that the part number has already been entered.

Enter a value of 2 for the Repeat count. 

Accept the default values for the Item weight classifi ca� on (Less than 5 lb (2.27 kg) and note that the envelope dimensions for 
a screw have already been entered.

The Screws serve no func� on except to fasten the cover in place.  Click Fasten or secure other items in the Item func� on group 
box.  Fasteners do not meet any of the three minimum part criteria and are automa� cally candidates for elimina� on from the 
product structure.  This is because, theore� cally, integral fastening elements could be incorporated into the secured items to 
make them self securing and eliminate the separate fasteners.  In the Notes group box enter Eliminate and make the cover 
self-fastening?

A screw requires 0 deg. of rota� on about its principal axis before it repeats its orienta� on.  The remaining two axes both 
require 360 deg. of rota� on before the orienta� on is repeated.  Click the One axis bu� on in the Symmetry group box.

The screws can be grasped with one hand and require no grasping tools and they present no addi� onal handling diffi  cul� es.  
Accept the default values in the Handling requirements and Handling diffi  cul� es group boxes.
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Click Threaded fastening for the securing process.

Assuming a screwdriver will be used to �ghten the screws, click Nut/screw driver for the Opera�on characteris�cs.  Accept the 
default value for the Number of revolu�ons (5).

Because there are no pilot points on the screws, click Not self-loca�ng in the Inser�on difficul�es group box.

The so�ware has es�mated 18.92 s to acquire and manually start the two screws, acquire a screwdriver and �ghten the two 
screws, and then set aside the screwdriver.

Click the Pneuma�c control entry on the structure chart and note in the Status bar that the so�ware has es�mated a �me of 
44.99 s to assemble one Pneuma�c control.  At the labor rate of 40$/hr and the Overall plant efficiency of 85%, the cost of that 
assembly labor is $0.59.

Product Redesign
Make a copy of the Piston analysis we’ve just completed.  Right click the Original design - Step 2 analysis tab at the top of the 
program window and click Copy from the pop-up menu.  Right click on the Original design - Step 2 analysis tab again and click 
Paste from the pop-up menu.  Double click the new tab and name it Redesign.

Click the Redesign bu�on at the top of the structure chart to display the Redesign worksheet.  Three categories of redesign 
sugges�ons are shown in the Sugges�ons for redesign panel on the right side of the program window.  These sugges�ons are 
listed in the order in which they should be evaluated and as the sugges�ons are selected, entries in the analysis are highlighted 
for the sugges�on.

With Candidiates for elimina�on other than fasteners and connectors selected on the right side of the window, the Steel spring 
and Steel cover are both highlighted as candidates for elimina�on within the product structure.  These redesign sugges�ons 
should be evaluated very carefully because these are the two sugges�ons that are likely to result in the largest reduc�ons in 
the cost of the product.

For the Steel spring, the note made during the original analysis indicates that it is theore�cally possible to combine the Steel 
spring with the Piston subassembly.    Although this is theore�cally possible, combining the two items is unlikely to result in a 
prac�cal part that will provide the necessary spring and piston func�onality within the product.  For this reason, this redesign 
sugges�on will no longer be considered and a combined spring/piston subassembly will not be included in the redesigned 
product.  This illustrates that not all redesign sugges�ons which are iden�fied in the original analysis will result in prac�cal 
redesign ideas that are carried forward into a product redesign.  Even so, it is s�ll best to iden�fy all theore�cal redesign 
sugges�ons when the original analysis is done and then abandon any that are imprac�cal at this point in the redesign process.

For the Steel cover the note made during the original analysis indicates that it may be possible to combine the steel cover with 
the Piston stop.  Imagine a plas�c piston stop that incorporates a cover feature to secure the top of the Steel spring in place.  
This redesign idea is quite prac�cal and will be carried forward into the redesigned product.  On the Redesign worksheet, click 
twice the name of the Piston stop and change it to Piston stop/cover.  Click the name of the Steel cover and delete it from 
the analysis by pressing the Delete key on your computer’s keyboard.  Move the Piston stop/cover to the end of the Redesign 
worksheet using Cut and Paste.  Click the name of the Piston stop/cover on the Redesign worksheet and then select Cut from 
the Edit menu at the top of your screen.  Click the name of the Screws on the Redesign worksheet and select Paste from the 
Edit menu.

On the right side of the screen, click Fasteners under the Category 2 redesign sugges�on label.  These redesign sugges�ons 
should only be considered a�er exhaus�ng all Category 1 redesign sugges�ons, for two reasons.  First, following a Category 1 
redesign sugges�on will frequently remove related fasteners, connectors, and separate opera�ons from the product making 
many Category 2 redesign sugges�ons superfluous.  Second, the product improvements a�ained by following a Category 2 
redesign sugges�on tend to be smaller than those a�ained when a Category 1 sugges�on is implemented.

The screws are highlighted as candidates for elimina�on within the product structure and the note made during the original 
analysis indicates that it may be possible to eliminate the screws by making the cover self fastening.  This is a prac�cal redesign 
idea that will be incorporated in the redesigned product by adding to the Piston stop/cover, features that snap into an annular 
groove within the bore in the plas�c base.  On the Redesign worksheet, click the name of the Screws and delete the items from 
the analysis by pressing the Delete key on your computer’s keyboard.  Click the name of the Piston stop/cover on the Redesign 
worksheet and then click the Ques�ons bu�on above the structure chart.  Click the Snap/Push fi�ng bu�on to change the 
securing process for the Piston stop/cover to snap fi�ng.  Click the Redesign bu�on to return to the Redesign worksheet.

There are no connectors or separate opera�ons in the analysis of the Pneuma�c control, so click the Category 3 redesign 
sugges�on Handling or inser�on difficul�es.  These redesign sugges�ons should be considered last because they normally 
generate the smallest of improvements in the product.  The Piston sub and the Steel spring are both highlighted within the 



Performing an Analysis / 7

DFA Product Simpli�ication
product structure.

The Piston sub is highlighted because, during inser� on, it is diffi  cult to align and presents resistance due to the hang up 
condi� on iden� fi ed in the original analysis.  One solu� on to this problem is to add a small projec� on to the top of the piston 
subassembly as shown below.  This projec� on would be used by the assembly worker as a handle to allow control of the piston 
subassembly during inser� on of the piston rod through the hole in the plas� c base.

 
This is a prac� cal idea to eliminate the piston subassembly’s inser� on diffi  cul� es and will be incorporated into the redesigned 
product.  On the Redesign worksheet, click the name of the Piston sub and then click the Ques� ons bu� on above the Structure 
chart.  Uncheck the Not self loca� ng checkbox and also uncheck the Resistance or hang up checkbox.  Click the Redesign bu� on 
to return to the Redesign worksheet.   

The Steel spring is highlighted on the Redesign worksheet because it presents a severe tangling situa� on that adds 2.67 s. of 
process � me during handling prior to inser� on.  With the small number of Pneuma� c controls produced, it is unlikely to be cost 
eff ec� ve to custom make a spring that does not tangle in order to save 2.67 s of process � me.  For that reason, this redesign 
sugges� on will be abandoned and the redesigned product will use the same off -the-shelf spring that is used in the original 
design.

When all of the prac� cal redesign ideas are incorporated into a new design of the pneuma� c control, the design pictured 
below is realized. 

Click the Ques� ons bu� on above the Structure chart and then click the Pneuma� c control entry on the Structure chart.  Note in 
the Status bar that the so� ware has es� mated a � me of 16.34 s to assemble a redesigned Pneuma� c control.  At the labor rate 
of 40$/hr and the Overall plant effi  ciency of 85%, the cost of that assembly labor is $0.21.

In order to make comparisons using the results features that are built into the DFA so� ware, the Original design- completed 
and Redesign - completed analysis tabs will be used.  These analyses are iden� cal to the analyses created in the present tutorial 
except that they also include part manufacturing cost es� mates for all parts within the original and redesigned Pneuma� c 
controls.

Click the Original design- completed analysis tab to select that analysis.  Click the Results menu at the top of your screen and 
then click Analysis totals - DFMA -> Include Tool Cost.   When the Select analyses dialog appears, select the Original design - 
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completed and the Redesign - completed analyses and click OK to display the result.

Note in the first table on the report that the Assembly process cost has been reduced from $0.59 down to $0.21, for a savings 
of $0.38 in assembly labor.  Also note that applying DFA to the pneuma�c control has reduced its total cost from $4.25 to 
$3.65, for a total cost reduc�on of $0.60 per product.  As indicated in the third table on the report, the produc�on life cost 
has been reduced from $42,527 to $36,532 for a total savings of just under $6,000 over the produc�on life of the pneuma�c 
control.

The pneuma�c control is a fairly simple product that is produced in somewhat low volumes.  Although the cost of this 
pneuma�c control was reduced just over 14 percent by applying DFA, experience has shown that much larger opportuni�es for 
savings exist when DFA is applied to more complex mechanical and electro-mechanical assemblies or to assemblies that are 
produced in higher volumes.  


